TA Instruments
~ | nstallation Requirements for
- TA Q SeriesThermal Analysis Systems

Notice

Thank you for ordering a Q Series thermal analysis system from TA Instruments. To ensure that
installation of your system goes as smoothly as possible and has you ready to start evaluating your sample
materials as quickly as possible, we are providing the attached installation information. It includes details
regarding laboratory space, power, and auxiliary requirements, as well as configuration requirements for
the controller (computer). Please review this information carefully and take any appropriate actions prior
to the installation date. To avoid unnecessary delays, and/or additional charges, please ensure that the
requirements specified in this document are met before your TA Instruments Service Representative
arrives. Contact your local TA Instruments Representative if you have any questions.

To arrange for installation of your system, contact our U.S. Service Department
(302-427-4050) or your local TA Instruments Service Representative.

Windows® 7,Windows 10, Windows Vista, and Microsoft Word® are registered trademarks of the Microsoft Corporation.
Intel® is a registered trademark of Intel Corporation.
Oracle® is a trademark or registered trademark of Oracle Corporation.
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Important: TA Instruments Manual Supplement

Please refer to the TA Manual Supplement to access the following important information supplemental to
this document:

* TA Instruments Trademarks

* TA Instruments Patents

e Other Trademarks

e TA Instruments End-User License Agreement

¢ TA Instruments Offices
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Requirements for the Controller (Computer)

A working thermal analysis system consists of one or more measurement instruments (e.g., DSC, TGA)
and a computer configured with appropriate TA Instruments software (this latter combination is
subsequently referred to as a controller). As a customer, you have two alternatives for configuring a
controller. You can either purchase a computer and have it configured by a TA Instruments Service
representative or you can purchase a suitable computer on your own and configure it at your site. In either
case, the general requirements which follow are the same.

In situations where you are supplying the computer, it is assumed that you have
reviewed these requirements and suitably prepared the controller prior to the
@ scheduled system installation by the TA Instruments Service Representative. In
fact, you will be required to provide hardcopy verification of your system setup
using the instructions on page 8 before an installation visit will be scheduled.

Before installing the TA Instruments software, you should ensure that the computer system meets the
following specifications:

Description Requirement
Operating system! Supported Operating Systems:32 & 64-bit versions of Windows Vista Business and
Ultimate and Windows 7 and Windows 10 Ultimate, Enterprise & Professional’
Processor Intel® 1 Core™ 2 Duo (2.93 GHz with 3 MB L2 cache) or better
Memory >4 GB RAM
Hard drive >80 GB free on hard drive
CD-ROM >48X CD-ROM or DVD
Screen resolution 1024 x 768 with >64K colors
Graphic memory 128 MB
Screen (LCD) size 19” or greater (24” wide screen recommended)

1. Install Microsoft Operating System Service Pack, Internet Explorer and/or Direct X (if required). If you
don't have the required versions of these packages, they can be obtained through the Microsoft web site
(at www.microsoft.com/downloads) or by using the Microsoft Windows Update mechanism (accessed
through the Start menu or by accessing http://update.microsoft.com).

2. Home version of Windows 7 and/or Vista is not acceptable. Home version is missing certain
functionality that is needed for optimized analyzer performance and efficiency.

The following Microsoft components are automatically installed as part of
Advantage V4.7 or higher: MS.NET Framework 2.0 and Microsoft Visual C++

@ 2005. These components support the latest software development tools used in
Advantage V4.8, as a result software installation may take longer than in previous
versions.
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Additional Requirements for Thermal Advantage Q Series"

Description

Requirements

Network card

10/100TX PCI Ethernet NIC for Advantage Q-Series' .

Ethernet hub/Switch ethernet cabling

10/100BaseTX Ethernet hub/switch for Advantage Q-Series'". Must be
EIA-568B Category 5 UTP.

TCP/IP ports

Network Services, as well as File & Printer Sharing for Microsoft
Networks, Client for Microsoft Network, and Internet Protocol (TCP/IP).

User Account Control (UAC) must be disabled for Windows to locate and connect
@ to instruments through explorer.

Additional Requirements for Universal Analysis

Description

Requirements

Support for custom reporting feature
of data analysis

Microsoft Word® 97 or higher, Microsoft Excel® 97 or higher, and
Adobe Acrobat Reader (provided with Advantage) are also required.

Color scheme

For Vista, Windows Aero is required (other schemes may result in broken
line display)

Additional Requirements for Instrument Control Software

Description

Requirements

User log-in capability

While multiple users may still use the “Fast User Switching” function
when running Windows Vista, only one user at a time may use the TA
Instruments Q Series™, Thermal, or Rheology Advantage Instrument
Control software. This limit, which is applicable to most programs, is a
result of hardware resources that are used by each of these programs.

Additional Requirements for TA Update*

Description

Requirements

Connectivity

Controller computer must be able to connect to the Internet. !

Log-in rights

Administrator

1. TA Update allows for online software updates. The entry of a user name and password is allowed in cases where
proxy or firewall authentication is required.
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Additional Requirements for VTI-SA/SA+

Description Requirements

Available PCI slot (1/2 height size) For VTI-SA+ camera option only

Software requirements: Microsoft Excel® 2007 or newer with Solver Add In, English version
(not supplied)

Free Disk Space Required

To help you determine which components to install, we have provided the following table containing the
approximate amount of free disk space required for installation of the TA Advantage software.

This amount is above that required for the operating system, plus the other
2 software products supplied on the installation CD-ROM. In addition, an extra 15
@ MB of free disk space is required during the install process (for temporary install

files.)
Data Analysis Only .
Software Thermal Only (Thermal) Rheology Only Full Installation
Q Series™ 684 MB 29 MB 344 MB 1057 MB
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Other Hardware Considerations

*  The computer should be a new computer that is not already attached to other analytical instruments.

» Before the TA Instruments Service Representative will schedule a visit to install new instruments,

please obtain a hard copy of the Windows® system summary as instructed below to verify that your
system is adequate. Please fax this verification sheet along with your company identification and
phone number to TA Instruments Service at 302-427-4054.

Obtaining Hardcopy System Verification For Windows
1 Select Programs> Accessories> System Tools> System | nfor mation from the Start menu.
2 Verify System Summary is highlighted.

If you print out this summary from this step you will receive all system information
@ (more than 50 pages). Follow the remaining steps to copy and print only summary
information.

3 Select Edit > Select All then Edit > Copy.
Open Notepad or another word processing program.
5 Select Edit > Paste then File> Print.

Other Software Considerations
*  Peripherals (e.g., printer) must be from the known Windows compatible list. (See Microsoft's web site
at http://www.microsoft.com/hwtest for the most current list.)

* TA Instruments is not responsible for resolving issues associated with connections to your corporate
network. [See further information in the next section. ]

* TA Instruments is not responsible for resolving hardware/software conflicts created by the addition of
third party hardware or software to the computer.
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System Configurations

TA Instruments Q Series” thermal analysis instruments communicate with the controller via TCP/IP. Each
TA Instruments controller requires an Ethernet hub/switch for configuring a local network (i.e., controller,
instrument(s), printer).

If you want to connect a thermal analysis controller with Q Series instruments to your in-house network,
additional considerations will apply. Review the scenarios shown below for the one that applies to your
situation.

¢ Controller Purchased from TA Instruments

If you wish to have your TA controller connected to your company network, you must supply a second
network interface card. The controller and Q Series instruments are shipped with pre-assigned (static)
“TA Instruments-compatible” IP addresses. Your MIS/IT department must supply and configure a
second Ethernet card for communication with your in-house network. Your TA Instruments
serviceman can install this second card during start-up of the system. Note: Using this configuration,
you can archive data to another computer on the network or print results on a network printer.

Using this configuration, you can archive data to another computer on the network
or print results on a network printer

e Software Suite Purchased from TA Instruments

If you wish to have your TA controller connected to your company network you must supply two
network interface cards. Your MIS/IT department should configure one of the Ethernet cards in the
computer that you are supplying for communication with your in-house network and must supply and
install a second card to be used with the TA Q Series instruments. Your TA Instruments service
representative will configure the second Ethernet card during start-up of the system to communicate
with the Q Series instruments.

Using this configuration, you can archive data to another computer on the network
or print results on a network printer
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Requirements for an Advantage Integrity ™
System (Applicable to Q Series™ Thermal
Instruments Only)

An Advantage Integrity system consists of an instrument, a computer for instrument control, and a
database server. To obtain installation requirements for the instrument and controller computer, refer to the
appropriate sections of this document. The Advantage Integrity systems rely on an Oracle® database
installed on a separate database server. This server can operate with the instrument and controller computer
as part of a LAN or it can reside on a network. The database server and Oracle software can be purchased
from TA Instruments or the customer can supply the server based on the requirements below. Contact TA
Instruments Service at 302-427-4050 (U.S.) or your local TA Instruments office for additional information
required for the installation of Advantage Integrity systems.

Database Server Requirements
The following are the requirements for the Advantage Integrity database system:

*  Minimum Hardwar e Specifications:
+ Intel® Core 2 Duo E4600 2.4 GHz Processor
* 2 GB memory
* 250 GB hard drive
*  Super Multi DVD2RW (£R DL) drive
* 10/100TX PCI Ethernet NIC network card

*  Oracle database software with the appropriate number of named user licenses. Global database name
and SID must be set to TAInstDB. Unicode character set must be used (AL32UTF8 or UTF8).

+ Oracle 12c Release 1: Windows® Server 2012 or Windows Server 2008
[English language version with English (US) regional settings].

Oracle 11g Release 1 or Release 2: Windows Server 2003 or Windows Server 2008
[English language version with English (US) regional settings].

* The Database Server must be dedicated to the TA Instruments system and not be used as a server for
other databases or any other type of servers such as file server, print server, etc.

*  The host name must not be changed after Oracle is installed on the server.
*  Available compatible tape drive or DVD+RW drive for database backup.

*  Prior to the installation visit, the customer must install the Oracle database server on their company
network (if a networked configuration is desired) and ensure that the computer is visible on network.
Network connection must be available in the location where the TA controller will be installed prior to
installation. TA Field Service Representative must have access to the appropriate MIS/IT personnel
during installation to resolve any networking issues.

»  Service installation should not be scheduled until the database server is connected and visible on you
company network. Verification of setup will be required. If you are supplying your own controller,
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then it too must be connected and visible on your company network following the network addressing
described in the Oracle Server Installation Instructions (P/N 925007.000).

Any needed Static IP addresses should be obtained from your IT department and taken out of the com-
pany’s list of assignable addresses.
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Requirements for Thermal Analysis Instruments

The following section summarizes laboratory requirements by instrument. Each section contains all of the
requirements for that particular instrument. Therefore, some items will be redundant if you have purchased
a multi-instrument system.

Q Series' " Instrument & Accessory Placement

The Q Series base system consists of a controller computer, Q Series instruments, and an optional cooling
accessory. For accessory setup information in addition to what is provided here, refer to “Requirements for
Miscellaneous Thermal Analysis Accessories” on page 25 of this document.

Select a location for the instrument with adequate floor space and a rigid laboratory bench that is level, has
a minimum depth of 76 cm (30 in), and with a length of approximately 183 cm (72 in). Please refer to the
layout shown in the figure below and the table on the next page for component placement.

Purge Gas Network {Optional)
Power Cooling Gas Power Power e
Accessory
Unit
Switch
{3?0% Q Series
Thermal Analysis
Cooling Instrument

Unit Controller

Computer

183 cm (72 in)

If you wish to have your TA controller connected to your company network, you must supply two network
interface cards. Your MIS/IT department should configure one of the Ethernet cards in the controller for
communication with your in-house network, and should supply and install a second card to be used with

the TA Q Series instruments. Your TA Instruments service representative will configure the second
Ethernet card during start-up of the system to communicate with the Q Series instruments.

Using this configuration, you can archive data to another computer on the
network or print results on a network printer.
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Q Series Instrument Cooling Unit Accessory Location of Cooling Unit
DSC All Q Series RCS — Table
DSC All Q Series LNCS — Floor
DSC Q2000/Q1000, Q200/Q100 | 1 PCA Table
TGA Q500, Q50 — Heat exchanger Table/floor
TGA Q5000 IR — Heat exchanger Table/floor
Q5000 SA — Heat exchanger Table/floor
SDT Q600 — — —
TMA Q400 MCA — Table/floor
MCA70 Floor
DMA Q800 GCA — Floor
ACS-3 Floor
NPC Bench next to DMA

1. RCS is an optional cooler with PCA in use.
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Q Series ' DSC

Dimensions:
Q20/Q10
Q200, Q100, Q2000, Q1000

Depth 56 cm (22 in), Width 46 cm (18 in), Height 41 cm (16 in)
Depth 56 cm (22 in), Width 46 cm (18 in), Height 48 cm (19 in)

Weight: 25 kg (54 1bs.); 8.6 kg (19 lbs) additional for built-in transformer for 230V
operation; 4.5 kg (10 lbs) additional for an Autosampler.
Power requirements: 120 VAC, 47-63 Hz, 500 W [4.5 A] (Installation Category II)

230 VAC, 47-63 Hz, 500 W [2.25 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions:

Temperature 15-35°C
Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment, away
from exposure to direct sunlight and direct air drafts. (Pollution Degree 2
Environment)

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements:

Purge Gas(es) Pressure'” 2

100—-140 kPa gauge (15-20 psig)

Cooling Gas (Air) Pressure for use with Finned Air Cooling Systeml’ 3
135-830 kPa gauge (20-120 psig)

Cooling Gas (Nitrogen) Pressure for use with RCS or LNCS!3
135-830 kPa gauge (20—120 psig)

Base Purge Gas Pressure for use with Quench Cooler, RCS or LNCS!3
100-140 kPa gauge (15-20 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gas and Base Purge Gas are connected to
the back of the instrument using 1/8-inch (O.D.) polyethylene tubing and Parker fittings. The Cooling
Gas is connected to the back of the instrument using %4 inch (O.D.) Polyflame tubing and a Parker fitting.
(The tubing and fittings are provided in the DSC accessory kit.) Acceptable cell purge gases include air,
nitrogen, oxygen, argon, and helium. Dry nitrogen should be used as the Base Purge gas. Dry nitrogen
should also be used as the cooling gas with the RCS and LNCS. Nitrogen that is 99.998% pure and <5
ppm H,0 is recommended.

2. Mass flow controllers (MFC) are a standard feature. Typical purge gas flow rate to the cell is 50 mL/min
with nitrogen. If your instrument does not have an MFC, an external flow meter is required.
3. Actual cooling gas and base purge gas flow rates are controlled by orifices installed in the DSC

References to “Installation Category” and “Pollution Degree” in this document are
defined in the safety standards to which this equipment has been evaluated.

Installation Category Il: The local level power distribution system intended to
2 power appliances, portable equipment, etc. with smaller transient overvoltages
@ than installation category lll. For mains supply the minimum and normal category

is Il.

Pollution Degree 2: Normally only non-conductive pollution occurs. Occasionally,
however, a temporary conductivity caused by condensation must be expected.
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Q20P/PDSC System

Dimensions:
Q20P/Q10P Depth 56 cm (22 in), Width 46 cm (18 in), Height 41 cm (16 in)
PDSC cell only Depth 24 ¢cm (9.3 in), Width 22.4 cm (9 in), Height 33 cm (13 in)

Weight:

Q20P/Q10P 25 kg (54 1bs.); 8.6 kg (19 lbs) additional for built-in transformer for 230V
operation; 4.5 kg (10 Ibs) additional for an Autosampler.

PDSC cell only 11 kg (23 Ibs)

Power requirements: 120 VAC, 47-63 Hz, 350 W [3 A] (Installation Category II)
230 VAC, 47-63 Hz, 350 W [1.5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15-35°C
Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment, away
from exposure to direct sunlight and direct air drafts. (Pollution Degree 2
Environment)

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Q20P/Q10P DSC — No additional requirements PDSC Cell — Customer-
supplied source of clean, dry pressurizing gas (inert, oxidizing, or reducing), and

all accessory regulators, gauges and tubing!. The gas is usually obtained from a
gas supply vendor in approved high-pressure tanks. If the PDSC Cell is to be
operated under vacuum conditions, the customer must supply the vacuum source.
The cell operating pressure range is from 1 Pa to 7 MPa (0.1 to 1,000 psig). If the
PDSC Cell is used in the dynamic or constant pressure mode, and an indication of
flow is required, an appropriate external flow meter must be obtained.

Contact TA Instruments for a listing of suitable gases and vacuum suggestions.

1. All tubing connecting the PDSC Cell to other devices (e.g., gas cylinders, gauges, valves, or regulators)
should be 3.18-mm (0.125-in) O.D. They must be rated for high pressure service to 21 MPa gauge
(3,000 psig) and free of hydrocarbons. The gas source regulator must be rated to withstand the source
pressure and possess two gauges—one to monitor the gas source pressure and the second to monitor the
regulator output pressure. The regular should cover the experimental range of the PDSC Cell (up to 7
MPa gauge [1,000 psig]).
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Q5000IR TGA

Dimensions: Depth 56 cm (22 in), Width 47 cm (19 in), Height 61 cm (24 in)

Weight: 37 kg (82 1bs.); 8.2 kg (18 lbs) additional for built-in transformer for 230V
operation

Power requirements: 120 VAC, 47-63 Hz, 1.2 kW [10 A] (Installation Category II)

230 VAC, 47-63 Hz, 1.2 kW [10 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions: Temperature 15-35°C (Note: TGA balance mechanism is sensitive to changes in
surrounding environmental conditions. For best results, room temperature should
be regulated to eliminate temperature variations)

Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment,
preferably on the ground floor in the building (a marble balancetableis
required for best results), away from pumps, motors, or other devices which
produce vibrations, and away from exposure to direct sunlight and direct air
drafts. (Pollution Degree 2 Environment).

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Purge Gas(es) Pressure!” 2
70-140 kPa gauge (10-20 psig)
Cooling Gas (Air) Pressure!
135-830 kPa gauge (20-120 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gases are connected to the back of the
instrument using 1/8-inch (O.D.) Polyethylene® tubing and Legris fittings. The Cooling Gas is con-
nected to the back of the instrument using % inch (O.D.) Polyethylene tubing and a Legris fitting. (The
tubing and fittings are provided in the TGA accessory kit.) Acceptable purge gases include air, nitrogen,
oxygen, argon and helium.

2. Purge gases are required for the balance and furnace/sample areas. Balance purge gas should always be
inert to protect the balance assembly. Mass flow controllers (MFC) are a standard feature of the Q5000
IR. Purge gas flow rates are 10 mL/min and 25 mL/min to the balance and furnace/sample areas respec-
tively.

Atmospheric pressure fluctuation can disturb sensitive TGA measurements.
Ventilation systems should operate air handlers continuously and efforts should

@ be made to minimize short term pressure fluctuations due to opening doors. Vents
that allow air to move between adjacent rooms through walls, doors, or ceilings
will help minimize measurement noise.
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Q5000 SA

Dimensions:

Depth 56 cm (22 in), Width 47 cm (19 in), Height 61 cm (24 in)

Weight:

40 kg (82 1bs.); 8.2 kg (18 Ibs) additional for built-in transformer for 230V
operation

Power requirements:

120 VAC, 47-63 Hz, [1.5 A] (Installation Category II)
230 VAC, 47-63 Hz, [1.5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions:

Temperature 15-35°C (Note: TGA balance mechanism is sensitive to changes in
surrounding environmental conditions. For best results, room temperature should
be regulated to eliminate temperature variations)

Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment,
preferably on the ground floor in the building (a marble balancetableis
required for best results), away from pumps, motors, or other devices which
produce vibrations, and away from exposure to direct sunlight and direct air
drafts. (Pollution Degree 2 Environment).

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements:

Purge Gas(es) Pressure'” 2

70-140 kPa gauge (10-20 psig)

Distilled water is required for humidity chamber

1. Purge gases are required for the balance and sample area (humidity chamber). Mass flow controllers
(MFC) are a standard feature of the Q5000 SA. Purge gas flow rates are 200 mL/min for the humidity
chamber and 10 mL/min to the balance. A gas dryer is supplied with the Q5000 SA.

2. Nitrogen purge gas is used for both the balance and sample area. The gas used must be dry and free of
oil, dirt and water. The purge gases are connected to the back of the instrument using 1/8-inch (0.D.)
Polyethylene® tubing and Legris fittings. (The tubing and fittings are provided in the Q5000 SA acces-

sory kit.)
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Q5000 SA Gas Plumbing Diagram

Mitrogen (Gas
2
Supply % Dryer
#1 1/4" tubing #5 1/8" tubing
We recommend a #3
Presssure regulator set 5
between 10 to 20 psig #5
Q5000 54
@ Cooling é))
See table on next page for Base  GasMax Gasl
parts list of this diagram. Purge 120psig
Gas Inlet, Back
Pang of QS000 54
Item Quantity Description
1 1 Regulator (not found in kit)
2 1 Legris 1/8-inch OD tube to 1/4-inch male NPT (American pipe thread)
3 1 Gas dryer, PN 200266.001
4 1 Legris “Y” 1/8-inch tube x 1/8-inch tube
5 15 ft Tubing Polyethylene 1/8-inch OD x.030-inch width
Notes:
1 TItem 1 can be purchased from TA Instruments.
2 Items 2 — 5 are located in the Accessory Kit.
3 Use 99.999% pure nitrogen to reduce moisture.
4 New or recently serviced and calibrated regulator is recommended.
5 Do not use Tygon tubing due to its high moisture permeability.
6 Make sure that the tubing is cut cleanly and squarely on the ends.
7 Leak check all tubing.
8 Use the supplied gas dryer, PN 200266.001, to prevent moisture buildup.
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050, Q500 TGAS

Dimensions (Q50/Q500):

Depth 56 cm (22 in), Width 47 cm (19 in), Height 52 cm (21 in)

Weight:

31 kg (68 1bs.); 8.2 kg (18 lbs) additional for built-in transformer for 230V
operation

Power requirements:

120 VAC, 47-63 Hz, 1.2 kW [10 A] (Installation Category II) - standard furnace
230 VAC, 47-63 Hz, 1.2 kW [5 A] (Installation Category II) - standard furnace

120 VAC, 47-63 Hz, 1.0 kW [8.3 A] (Installation Category II) - EGA furnace
230 VAC, 47-63 Hz, 1.0 kW [4.2 A] (Installation Category II) - EGA furnace

1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions:

Temperature 15-35°C (Note: TGA balance mechanism is sensitive to changes in
surrounding environmental conditions. For best results, room temperature should
be regulated to eliminate temperature variations)

Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment,
preferably on the ground floor in the building (a marble balancetableis
required for best results), away from pumps, motors, or other devices which
produce vibrations, and away from exposure to direct sunlight and direct air
drafts. (Pollution Degree 2 Environment).

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements:

Purge Gas(es) Pressure!” 2

70-140 kPa gauge (10-20 psig)

Cooling Gas (Air) Pressure!

135-830 kPa gauge (20—120 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gases are connected to the back of the
instrument using 1/8-inch (O.D.) Polyethylene® tubing and Legris fittings. The Cooling Gas is con-
nected to the back of the instrument using % inch (O.D.) Polyethylene tubing and a Legris fitting. (The
tubing and fittings are provided in the TGA accessory kit.) Acceptable purge gases include air, nitrogen,
oxygen, argon and helium

2. Purge gases are required for the balance and furnace/sample areas. Balance purge gas should always be
inert to protect the balance assembly. Mass flow controllers (MFC) are a standard feature of the Q500
and Q50. Purge gas flow rates are 40 mL/min and 60 mL/min to the balance and sample areas respec-
tively for the standard furnace. They are 10 mL/min and 90 mL/min to the balance and sample areas for

the EGA furnace.
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Q600 SDT

Dimensions:

Depth 56 cm (22 in), Width 60 cm (23 in), Height 48 cm (19 in)

Weight:

Weight with transformer:

32 kg (70 Ibs)
40 kg (88 1bs)

Power requirements:

120 VAC, 47-63 Hz, 1.2 kW [10 A] (Installation Category II)
230 VAC, 47-63 Hz, 1.2 kW [5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions:

Temperature 15-35°C

Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment,
preferably on the ground floor in the building (a marble balancetableis
required for best results), away from exposure to direct sunlight and direct air
drafts. (Pollution Degree 2 Environment).

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements:

Purge Gas(es) Pressure'” 2

70-140 kPa gauge (10-20 psig)

Cooling Gas (Air) Pressure!

135-830 kPa gauge (20—120 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gases are connected to the back of the
instrument using 1/8-inch (O.D.) Polyethylene® tubing and Legris fittings. The Cooling Gas is con-
nected to the back of the instrument using % inch (O.D.) Polyethylene tubing and a Legris fitting. (The
tubing and fittings are provided in the SDT accessory kit.) Acceptable purge gases include air, nitrogen,
oxygen, argon and helium.

2. A mass flow controller (MFC) is a standard feature and is used to regulate the purge gas. Typical purge
rates are 100 mL/min. If your instrument does not have an MFC, an external flow meter is required.
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Q400 TMA

Weight with transformer:

Dimensions Depth 56 cm (22 in), Width 46 cm (18 in),
Height with furnace open 65 cm(26 in); Height with furnace closed 61 cm (24 in)
Weight: 32 kg (70 Ibs)

40 kg (88 1bs)

Power requirements:

120 VAC, 47-63 Hz, 1.2 kW [10 A] (Installation Category II)
230 VAC, 47-63 Hz, 1.2 kW [5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions:

Temperature 15-35°C

Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment,
preferably on the ground floor in the building (a marble balancetableis

required for best results), away from exposure to direct sunlight and direct air
drafts. (Pollution Degree 2 Environment).

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements:

Purge Gas(es) Pressure!” 2

70-140 kPa gauge (10-20 psig)

Cooling Gas (Air) Pressure!

135-830 kPa gauge (20—120 psig)

1. All gases must be dry and free of oil, dirt and water. The Purge Gases are connected to the back of the
instrument using 1/8-inch (0.D.) Polyethylene® tubing and Legris fittings. The Cooling Gas is con-
nected to the back of the instrument using 4 inch (O.D.) Polyethylene tubing and a Legris fitting. (The
tubing and fittings are provided in the TMA accessory kit.) Acceptable purge gases include air, nitrogen,
oxygen, argon and helium.

2. A mass flow controller (MFC) is a standard feature and is used to regulate the purge gas. Typical purge
rates are 100 mL/min. If your instrument does not have an MFC, an external flow meter is required.
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Q800 DMA

Weight with transformer:

Dimensions Depth 56 cm (22 in), Width 46 cm (18 in),
Height with furnace open 71 cm(28 in); Height with furnace closed 56 cm (22 in)
Weight: 32 kg (70 Ibs)

40 kg (88 1bs)

Power requirements:

120 VAC, 47-63 Hz, 600 W [5 A] (Installation Category II)
230 VAC, 47-63 Hz, 600 W [2.5 A] (Installation Category II)
1.44 kW max with full power delivered through accessory outlets.

Laboratory conditions:

Temperature 15-35°C

Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment, preferably
on the ground floor in the building (a marble balance tableisrequired for best

results), away from exposure to direct sunlight and direct air drafts. (Pollution
Degree 2 Environment).

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements:

Air Bearing Gas Pressure! 2

410-450 kPa gauge (60—65 psig); flow rate 4 L/min

Cooling Gas (Air) Pressure!

175-830 kPa gauge (20—120 psig)

1. All gases must be dry and free of oil, dirt and water. The Cooling Gas is connected to the back of the
instrument using Y4 inch (O.D.) Polyethylene® tubing and a Legris fitting. (The tubing and fittings are
provided in the DMA accessory kit.)

2. TA Instruments' Air Compressor Accessory (ACA) is available for laboratories that do not have a suit-
able gas supply for the air bearings.
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VTI-SA / VTI-SA+

1

Dimensions:

VTI-SA Depth 42 ¢cm (16.5 in), Width 30.5 cm (12 in), Height 64 cm (25 in)
VTI-SA+ Depth 44.5 cm (17.5 in), Width 43 cm (17 in), Height 67 cm (26.5 in)
Weight:

VTI-SA 32 kg (71 1bs)

VTI-SA+ 40 kg (89 1bs)

Software requirements:

Microsoft Excel® 2007 or newer with Solver Add In, English version (not supplied)

Power requirements:

Three 120 or 230 VAC electrical outlets are required for connecting the instrument,
computer and monitor on a grounded breaker with a minimum of 20 or 15

(230 VAC) amps available.

120 VAC, 47-63 Hz [1.5 A] (Installation Category II)

230 VAC, 47-63 Hz [0.75 A] (Installation Category II) 1.44 kW max with full
power delivered through accessory outlets.

Laboratory conditions:

Temperature 15-30°C
Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment, preferably
on the ground floor of the building (a marble balance tableis strongly
recommended for best results), away from pumps, motors, or other devices which
produce vibrations, and away from exposure to direct sunlight and direct air drafts.
(Pollution Degree 2 Environment).

Laboratory requirements:

Nitrogen gas2 is used to generate the humidity and dry mixtures.
Dew point < -40°C.

Gas Pressure 70—140 kPa gauge (10-20 psig); an individual two-stage pressure
regulator is required.

Distilled water is required for humidity chamber (highest purity available is best).

(Organic option)

Laboratory requirements:

Requires a % inch or 6 mm OD line from the vent port of the instrument to a fume
hood, window or other ventilation vehicle; the vent line should be Teflon® or
stainless steel.

1. Allow for additional room to the sides and back of the unit for access during installation and mainte-

nance.

2. All gases must be dry and free of oil, dirt and water. The nitrogen line is connected to the back of the

instrument using %4 inch (O.D.) Polyethylene® or stainless steel transfer line tubing and 4 inch or 6 mm
fitting. (The fitting at the unit is supplied on the instrument. The connection from the tank to the instru-
ment is provided by the customer.

Additional Requirements for VTI-SA+ Camera Option

Description

Requirements

Available PClIe slot (1/2-height size) | One 1/2-height PCle slot is required for video capture card.

Electrical outlet

One 120 or 230 VAC as specified above.
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VTI-SA Plumbing Diagram
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Requirements for Miscellaneous Thermal
Analysis Accessories

Refrigerated Cooling System (RCS120, RCS90, RCS40)
for use with DSC Instruments.

Specification RCS120 RCS90 RCS40

Height 88 cm (34.6) 46 cm (18 in) 26 cm (10 in)

Width 35.6 cm (14.5) 26 cm (10 in) 26 cm (10 in)

Depth 56 cm (22 in) 51 cm (20 in) 51 cm (20 in)

Power requirements 230 VAC/8.5 A/50 Hz 120 VAC/12 A/60 Hz 120 VAC/6.25 A/60 Hz
230 VAC/7.5 A/60 Hz 220 VAC/6 A/50 Hz 220 VAC/4 A/50 Hz

Weight 102 kg (225 Ibs) 47.7 kg (105 Ibs) 24.8 kg (55 lbs)

Laboratory requirements | Same general environmental requirements as DSC. A base and cooling purge
(nitrogen) is required in addition to the standard cell purge.

If using an RCS as your cooling accessory, it is ideal to place the RCS on a table that is separate from your
laboratory bench. If a table is not available, place the RCS on the laboratory bench to the right of the
Discovery Series instrument.

Refer to the Refrigerated Cooling System Getting Started Guide for more information.

Page 25



Below is a schematic showing you how to connect the gas plumbing lines to the instrument for the use of
the RCS.

RCS Gas Plumbing Diagram

See table below for parts

MNitrogen Gas list of this diagram.
Z
Supply % Cryer
®3/1: 4" tubing 8 1/4" tubing
#6
~
1
Pressure #7 — ) )
regulator set 1/8" tubing 5
ko 20psig Ty —
QDSC
Gasl Gass
4
il [:I__© Cooling
Base 3as Max
Purge 120psig

©

Gas Inlet
back panel
-

Item Quantity Description
1 1 Regulator (not found in kit)
2 1 Legris 1/4-inch OD tube to 1/4-inch male NPT (American pipe thread)
3 1 Legris 1/4-inch OD tee x 1/8-inch OD tube
4 1 Legris “Y” 1/8-inch tube x 1/8-inch tube
5 15 ft Tubing, polyethylene, 1/8-inch OD x.030-inch width
6 25 ft Tubing, Polyflame, 1/4-inch OD x.040-inch width
7 1 Gas dryer, PN 200266.001 (not found in kit)
Notes:
1 Items 1 and 7 can be purchased from TA Instruments.
2 Items 2 — 6 are located in the DSC Accessory Kit, 970012.901.
3 Use 99.999% pure nitrogen to reduce moisture
4 New or recently serviced and calibrated regulator is recommended.
5 Do not use Tygon tubing due to its high moisture permeability.
6 Make sure that the tubing is cut cleanly and squarely on the ends.
7 Leak check all tubing.
8 Use gas dryer, PN 200266.001, to prevent moisture buildup.
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Liquid Nitrogen Cooling System (LNCS) for use with DSC
Instruments

See the figure below for the correct placement of the LNCS unit on the floor to the left of the QDSC
instrument.

Dimensions Width (diameter) 53 cm (21 in), Height 109 cm (43 in)
(Unit designed to be placed on the floor.)

Weight: 52 kg (113 Ibs) empty
88 kg (193 1bs) full

Power requirements: 85-264 VAC, 50/60 Hz, 0.18 kW

Laboratory conditions: Temperature 15-35°C

Relative Humidity 5-80% (non-condensing)

Instrument should be located in a dust-free, vibration-free environment, preferably
on the ground floor in the building (a marble balance tableisrequired for best
results), away from exposure to direct sunlight and direct air drafts. (Pollution
Degree 2 Environment).

Maximum Altitude 2000 m (6560 ft)

Laboratory requirements: Same general environmental requirements as DSC. LNCS autofills during usage.
Should be connected to a 160 L liquid nitrogen tank with pressure of 150-170 kPa
gauge (22-25 psig). A base and cooling purge (nitrogen) is required in addition to
the cell purge. Helium cell purge is required when operating below —100°C.

On the next page is a schematic showing you how to connect the gas plumbing lines to the instrument for
the use of an LNCS.
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LNCS Gas Plumbing Diagram

LS #2354
#6,7
Supply # v
1/4" tubing -~ 1/4" tubing
~
Important Mote : Pressure
Use the Gas Regulator set 1,8 tubing
Supply only bto 20psig
QOSC
Gasl Gas?
| #9 [P{) Cooling
Gas 2 Optional _ Base zas Max
Supply Gas Dryer Gas Purifier Purge 120psig
e o
#1
- Gas Inlet
Optional Znd gas #14 #15 bad: panel
Typicalky Halium
Regulator set to 20 psig
1/8" tubing
House
Nitrogen
Supply
1/4" tubing 3 ToLNCS Ext
#1 { Pressurizabion
Regulator
setto 10 psig
Item Quantity Description
1 2 Regulator, 0 to 40 psig out (not found in kit)
2 1 92 Nut, CGA-580
3 1 15-3 Nipple CGA-580
4 1 Coupler, female-female 1/4-inch NPT (NPT=American pipe thread)
5 2 Legris plug-in reducer 1/8-inch OD x 1/4-inch OD
6 1 Legris male run Tee 1/4-inch OD x 1/4-inch NPT
7 1 Legris plug 1/4-inch OD
8 1 Legris tee 1/4-inch x 1/8-inch tube
9 1 Legris union “Y” 1/8-inch tube to 1/8-inch tube
10 1 Legris 1/4-inch OD tube to 1/4-inch male NPT
11 1 Legris 1/8-inch OD tube to 1/4-inch male NPT
12 15 ft Tubing, polyethylene, 1/8-inch OD x.030-inch width
13 25 ft Tubing, Polyflame, 1/4-inch
14 1 Gas dryer, PN 200266.001 (not found in kit)
15 1 Purge gas purifier, PN 970425.901 (not found in kit)
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Notes:

Items 1, 14, and 15 can be purchased from TA Instruments.

Items 2-5 are in the LNCS Accessory Kit (970398.901)

Items 6—13 are in the DSC Accessory Kit (970012.901)

Use new or recently serviced and calibrated regulators.

Do not use Tygon tubing due to its high moisture permeability.
Make sure that the tubing is cut cleanly and squarely on the ends.
Leak check all tubing.

Use 99.999% pure Helium to reduce moisture buildup in the cell.

© 0O N O O & W DN PP

Use the gas dryer, PN 200266.001, to pre-dry and indicate unsatisfactory moisture levels.
10 Use the purge gas purifier, PN 970425.901, to achieve a dewpoint of —180°C.
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Finned Air Cooling System (FACS) for use with DSC
Instruments

This section provides the laboratory requirements for the FACS and a schematic showing you how to
connect the gas plumbing lines to the instrument for the use of an FACS.

Laboratory requirements:
* Same general environmental requirements as DSC.
*  Cooling Gas (Air) Pressure for use with Finned Air Cooling System

135-830 kPa gauge (20—120 psig)

FACS Gas Plumbing Diagram

Nitrogen 11
Supply 46
#1 #5 j/_ 1/8" tubing ,.f’a 1/8"tubing ¥4
Pradsure Gas
regul abor set #4 O
to 20psig Dryer = <
Base ool Gasl as2
oling
Air Purge @Gas Ml
Sy |C)| 120psig
PRLY N . zas Inlet
#1 ®:=; 1,/4" tubing 1/4"tubing  #5 back panel
120psi g maxnunn
We recommend a
Presssure regulator set
hebween 20 to 120psig
Item Quantity Description
1 1 Regulator (not found in kit)
2 1 Legris 1/8-inch OD tube to 1/4-inch male NPT (NPT=American pipe thread)
3 1 Legris “Y” 1/8-inch tube x 1/8-inch tube
4 15 ft Tubing, polyethylene, 1/8-inch OD x.030-inch width
5 25 ft Tubing, Polyflame, 1/4-inch OD x.040-inch width
6 1 Gas Dryer, P/N 2006.001 (not found in kit)

Notes:

* Item 1 can be purchased from TA Instruments.

* Items 2-5 are located in the DSC Accessory Kit, 970012.901.

*  FACS uses cool gas constantly; therefore clean house air should be used. A filter is recommended.
*  Use standard grade nitrogen.

* New or recently serviced and calibrated regulator is recommended.

*  Make sure that the tubing is cut cleanly and squarely on the ends.

* Leak check all tubing.
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QDSC (with 2nd Gas) Plumbing Diagram

Mitrogen (Gas
Supply Ciryer

1/4" tuhing 1/4" tuhing
"\\
1/8" tubing

Pressure
Rgulator set 1/8" tubing

o 20psig I

QOSC

Gasl GasZ
Opfional []'__© Coding

MdGas Base i5as Max
Supply Gas Dryer Furge  |120rsia

®=u 4" tubing 1/8" tubing ©

Pressure
Rgulator set .
to 20psig
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DMA-RH Accessory

Dimensions of control enclosure

Dimensions of sample chamber
with attached transfer line

Height: 37 cm (14.5 in)
Width: 30.5 cm (12 in)
Depth: 51 cm (20 in)

Height: 15 cm (5 % in)

Width: 21 cm (8 % in)

Depth: 18.5 cm (7 %)

Transfer line length: 2.1 meters (7 feet)

Weight of control enclosure
(without water)

Weight of sample chamber with
transfer line

27.2 kg (60 1bs)

3.2 kg (7 1bs)

Electrical inlet power requirements

Voltage: 90-265 VAC
Frequency: 45— 65Hz

Energy consumption

0.400 KVA

Laboratory conditions:

Temperature 15-35°C

Relative humidity 5% to 80% RH from 15°C to 31°C, decreasing to 66%
RH at 35°C (non-condensing)

Instrument should be located in a dust-free, vibration-free environment,
preferably on the ground floor in the building away from pumps, motors, or
other devices which produce vibrations.

Away from any type of magnetic field generating equipment, and away
from exposure to direct sunlight and direct air drafts. (Pollution Degree 2
Environment).

Laboratory requirements:

Filtered nitrogen with dew point of —40°C or less
Pressure: 138 kPa gauge (20 psi gauge)
Volume: 3 SLPM
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DMA-RH Back Panel Connections

Power cord

Instrument port

N2/DRY AIR inlet port

Drain valves
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Photocalorimeter Accessory (PCA) for use with DSC
Q2000 and DSC Q200

Dimensions

Depth 44 cm (17 in) Width 28 cm (11 in), Height 15 cm (6 in)

Weight:

9.4 kg (21 1bs)

Power requirements:

90-132 VAC (3.5 A) / 180-246 VAC (2.0 A), 47-63 Hz; autorange selectable

Laboratory requirements:

Same general environmental requirements as DSC Q Series.

Air Compressor Accessory (ACA) for use with DMA Q800

Dimensions Depth 38 cm (15 in), Width 38 cm (15 in), Height 23 cm (9 in)
Weight: 10 kg (22 1bs)
Power requirements: 120 VAC, 50/60 Hz, 0.3 kW

Laboratory requirements:

Same general environmental requirements as DMA. Should not be located in an
enclosed area. Heat build-up occurs if air does not flow freely around the unit.

Requires the use of a moisture filter regulator with autodrain, which is included
with the DMA.

Gas Cooling Accessory (GCA) for use with DMA Q800

Dimensions

Width (diameter): Dewar 46 cm (18 in), Feet 79 cm (31 in); Height: 107 cm (42 in)

Weight:

46 kg (101 1bs.) - empty
87 kg (191 1bs) - full

Power requirements:

120 VAC at 0.9 kW, 47-63 Hz

Laboratory requirements:

Same general environmental requirements as DMA. GCA is refilled by connecting
to a 160 L liquid nitrogen tank with pressure of 150-170 kPa gauge (20-25 psig).

Mechanical Cooling Accessory 70 (MCA70) for use with
TMA Q400/Q400EM

Dimensions

Depth 51 ¢cm (20 in), Width 26 cm (10 in), Height 46 cm (18 in)

Weight:

47.7 kg (105 Ibs)

Power requirements:

120 VAC/ 12 A/ 60 Hz
220 VAC /6 A/ 50 Hz

Laboratory requirements:

Same general environmental requirements as TMA. No additional purge gas
requirements.
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Mass Spectrometer for use with TGA Instruments

Instrument compatibility

Discovery TGA, Q Series TGA

Dimensions (not including capillary)

Depth 61.5 cm (24 in)
Width 26 cm (10 in)
Height 41 cm (16 in)

Weight 28 kg (62 1bs)

Power

Power adapter 240 VAC / 2A, 100 VAC / 5A, 50/60Hz
Pump inlet 24VDC, 2.5A

Backing pump 24VDC, 3.15AT

Turbo pump 5.0AT

Heaters 8.0AT

Mains inlet 6.3 AT

All fuses 250 VAC 5x20 mm Ceramic Fast Acting

Laboratory conditions

Temperature 15-35°C

Relative humidity 5-80% (non-condensing)
Installation Category II

Pollution Degree 2

The degree of protection for this instrument according to IEC 529 to
1P20.

Maximum altitude 2000 m (6560 ft)
Instrument should be located

Dust-free, vibration-free, sun-free, draft-free!

Laboratory requirements (High Pressure
MS, only)

Purge gas pressure 7-14 kPa gauge (1-2 psig)2

1. Instrument should be located in a dust-free, vibration-free environment, preferably on the ground floor of
the building (a marble balance tableisrequired for best results), away from pumps, motors, or other
devices which produce vibrations, and away from exposure to direct sunlight and direct air drafts.

2. The purge gas should be dry and free of oil, dirt and water. The Purge Gas is connected to the back of the
instrument using a % inch (O.D.) compression fitting. Acceptable purge gases include nitrogen or argon.
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Air Chiller System (ACS) and Chiller Panel for use with

Q800 DMA

ACS2 ACS3
Dimensions of Air Chiller
(Hx W x D):
Without Chiller Panel 88.5 cm (351in) x 37 cm (14.5 in) x 112 cm (44 in) x 37 cm (14.5 in) x 56 cm
56 cm (22 in) (22 in)
With Chiller Panel 88.5 cm (35 1in) x 52 cm (20.5 in) x 112 cm (44 in) x 52 cm (20.5 in) x 56 cm
56 cm (22 in) (22 in)
Weight of Air Chiller:
Without Chiller Panel 96 kg (211 Ibs) 121 kg (267 lbs)
With Chiller Panel 112 kg (247 1bs) 137 kg (302 Ibs)

Dimensions of Chiller
Panel:

Height: 86.4 cm (34 in)
Width: 48.3 cm (19 in)
Depth:38.1 cm (15 in)

Height: 86.4 cm (34 in)
Width: 48.3 cm (19 in)
Depth:38.1 cm (15 in)

Weight of Chiller Panel:

15.8 kg (35 Ibs) 15.8 kg (35 Ibs)

Power requirements:

220-230 VAC
50 Hz or 60 Hz (refer to the serial number plate on the rear of the unit)
Nominal 9.3A, Max 12A

Refrigerants

1st Stage: R404A

2nd Stage: R290 & R508B

Each in varying amounts and substan-
tially less than 500g each.

Ist Stage: R404A

2nd Stage: R290 & R508B

3rd Stage: R290 & R14

Each in varying amounts and
substantially less than 500g each.

Cooling Gas requirements:

Gas: Air or nitrogen

Pressure: 6.2-6.9 bar (90-100 psi)
Flow rate: 200 L/min
Temperature: 20-30°C

Dew pointl: Must not exceed the ambient air temperature by more than 5°C.

Ambient Air? 12°C-21°C = Acceptable

21°C-24°C = Ideal

Heat Generation: ACS-3: 1800 W; ACS-2: 1450 W
Operating altitude 2000 meters maximum

Relative humidity

5% to 80% RH from 15°C to 30°C

1. Dew point is specified at operating pressure.
2. The ACS generates a significant quantity of heat when running. These operating temperatures must be
maintained during system operation.
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Nitrogen Purge Cooler Accessory for use with Q800 DMA

Dimensions of Dewar Height: 15 in.
flask: Width: 12 in.
Depth: 7 in.
Volume: 2.5 L
Weight of Dewar flask 6 1bs (without liquid nitrogen)

Cooling Gas requirements: | Gas: Nitrogen ONLY
Pressure: 25-120 psi
Flow rate: 30 I/min
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TA Instruments Offices

For information on our latest products, contact information, and more, see our web site at:
http://www.tainstruments.com

TA Instruments — Waters LLC
Corporate Headquarters

159 Lukens Drive

New Castle, DE 19720

USA

Telephone: 302-427-4000
Fax: 302-427-4001
Email: info@tainstruments.com
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